


Владимир Сергеевич Пташинский
Photoshop CS4 для фотографов

 
 

Текст предоставлен издательством
http://www.litres.ru/pages/biblio_book/?art=2447845

Photoshop CS4 для фотографов: Эксмо; Москва; 2010
ISBN 978-5-699-36325-4

 

Аннотация
Чем отличаются фотоснимки, сделанные любителем и профессионалом? Отличий

множество. Самое главное – каждый снимок, сделанный профессионалом, уникален, а
любительские фотографии похожи друг на друга.

Фотосъемка – это целое искусство, и качество готовой фотографии в большой степени
будет зависеть от того, насколько правильно сделан снимок. Но даже не самый удачный
кадр можно улучшить, а иногда можно «вытянуть», казалось бы, безнадежные снимки. В
этом вам поможет популярный редактор растровой графики Adobe Photoshop CS4.
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Фотостудия на вашем столе

(вместо предисловия)
 

Сегодня цифровая графика – неотъемлемая часть нашей жизни. С ней приходится рабо-
тать дизайнерам, фотохудожникам, людям, занимающимся моделированием и проектирова-
нием. Есть даже более простой пример: почти у каждого сегодня имеется цифровая фото-
камера. А снимок, сделанный с помощью такой камеры, – не что иное, как файл цифровой
графики.

Развитие цифровых технологий и их тесная интеграция в нашу жизнь позволили
использовать компьютер для выполнения множества задач. Мы уже забыли, что такое печат-
ные машинки, проявка фотопленки, постепенно становятся ненужными чертежные инстру-
менты, органайзеры и многие другие вещи. Очень многие инструменты легко могут быть
заменены клавиатурой и мышью. Не обошло это стороной и фотографию.

Кратко напомним, как делалась фотография еще совсем недавно. Сначала фотографи-
руемое изображение через объектив фотоаппарата попадало на участок фотопленки, назы-
ваемый кадром. Фотопленка обладает светочувствительностью, поэтому на ней фиксирова-
лись более или менее освещенные участки. Затем пленку проявляли в специальном растворе
(проявителе) и закрепляли результат другим раствором (фиксажем). И все это в полной тем-
ноте. Длительность проявки играла важную роль: недодержать или передержать пленку в
проявителе практически всегда означало испортить кадры. Безвозвратно. В результате про-
явки изображение на пленке становилось видимым (разные по освещенности участки изоб-
ражения имели разную степень прозрачности). Затем пленка заправлялась в фотоувеличи-
тель, который проецировал изображения кадров на фотобумагу (тоже чувствительную к
свету). Все это делалось почти в полной темноте, где источником света служил лишь туск-
лый красный фонарь (фотобумагу делали нечувствительной к красному цвету). Длитель-
ность проецирования изображения на фотобумагу тоже была важна. Фотобумага подверга-
лась проявке и закреплению, после чего фотографии сушили или глянцевали.

Как видите, процесс от нажатия кнопки затвора на фотоаппарате до помещения гото-
вой фотографии в альбом был достаточно длителен и трудоемок. Мало того, необходимо
было знать все тонкости фотографического дела и учиться как на чужих, так и на собствен-
ных ошибках. А можно было отдать отснятую пленку в фотоателье, где за определенную
сумму ее проявляли и печатали фотографии. Удобно, но не всегда. У каждого могут быть
снимки, не предназначенные для посторонних глаз. Конечно, процесс создания фотографии
был длителен, но это было настоящее увлечение, хобби. И человек, умеющий фотографиро-
вать и делать фотографии, пользовался уважением среди друзей и знакомых.

А что сейчас? Мир объят бумом цифрового фото. Цифровая камера есть практически
у каждого: у кого-то «цифромыльница», у кого-то профессиональная «зеркалка». Процесс
фотосъемки в большинстве случаев сводится к нажатию всего одной кнопки. Все остальное
камера делает сама. В результате нажатия кнопки спуска затвора на цифровой камере на
карту памяти записывается графический файл с изображением того, что попало в объектив.
Этот файл можно сразу посмотреть на дисплее камеры, записать на жесткий диск компью-
тера, оптический диск или распечатать на принтере. Все. Можно наслаждаться просмотром
запечатленных мгновений. Если раньше фотограф тщательно выбирал кадры для съемки



В.  С.  Пташинский.  «Photoshop CS4 для фотографов»

5

(фотопленка имела ограниченное количество кадров, как правило, 18, 24, 36, в редких слу-
чаях – 72), то теперь мы снимаем все подряд, даже то, что никто потом и смотреть не будет, –
емкость современных карт памяти позволяет уместить тысячи снимков.

Но наша книга как раз для тех, кто хочет превратить свои снимки в художественные
шедевры. Пусть не все снимки, а только избранные. Почти в любой фотографии есть что
улучшить: выровнять яркость, откорректировать цвета, устранить дефекты съемки, «зама-
зать» прыщ на лбу и даже избавить объект съемки от лишних килограммов веса! Кажется
невероятным, но сегодня все это можно сделать с помощью одного универсального инстру-
мента. И имя этому инструменту – персональный компьютер с установленной программой
Adobe Photoshop.

Данная книга ориентирована на тех, кто уже сталкивался с Photoshop. Эта программа
содержит огромное количество функций и инструментов, и мало кто знает Photoshop в совер-
шенстве. Очень многие используют ограниченный набор инструментов, чтобы, например,
изменить яркость снимков, добавить на них текст, обрезать лишнее и т. д. Мы же будем
говорить о некоторых приемах работы, которые позволят повысить уровень ваших знаний
в работе над цифровыми фотографиями.

Чего вы не найдете в данной книге? Как уже отмечалось, книга рассчитана на читате-
лей, хоть немного знакомых с программой Photoshop. Поэтому мы не будем описывать такие
базовые операции, как создание, открытие и сохранение файла, состав палитры инструмен-
тов, масштабирование изображения, технологии рисования различными инструментами,
методы выбора кистей – все то, что подробно описывается в самоучителях, ориентирован-
ных на начинающих пользователей. Если вы таковым являетесь, то есть никогда не рабо-
тали с Photoshop, скорее всего, многие вещи в данной книге останутся вам непонятными.
Впрочем, если ранее вы работали с такими программами, как CorelPAINT, GIMP или даже
Paint.NET, то легко сможете перейти на Photoshop, возможно, даже без изучения соответ-
ствующей литературы.

Программа Photoshop находит множество применений: работа с фотографиями, раз-
личными рекламными макетами, заготовками для программ видеомонтажа и трехмерного
моделирования, создание открыток, композиций, коллажей. И конечно, ретушь фотосним-
ков. Именно о ретуши мы будем говорить в этой книге.

Что такое ретушь? В самом простом смысле это редактирование фотографий с целью
придания изображению законченного вида: устранение различных дефектов снимка, коррек-
ция яркости и контрастности, цветовой гаммы и насыщенности и т. п. Цель ретуширования –
сделать фотографию такой, какой вы хотели бы ее видеть, или подготовить в соответствии с
определенными требованиями. Согласитесь, фотография, снятая дешевым фотоаппаратом и
помещенная без обработки на обложку глянцевого журнала, испортит всю обложку. Посмот-
рите свои цифровые снимки. Возможно, большинство из них далеки от идеала: какие-то
чрезмерно темные, где-то цвета не совсем естественные, у кого-то красные глаза и синие
круги под ними. Все это можно исправить. Даже цифровую фотографию, сделанную «циф-
ромыльницей», в ряде случаев можно превратить в высокохудожественное фото.

Вы, наверное, заметили, что мы уже не в первый раз употребляем странный термин
«цифромыльница». Это народное название цифровых фотоаппаратов низкого и среднего
ценового сегмента. Название «мыльница» пришло еще от пленочных фотоаппаратов, рабо-
тающих полностью в автоматическом режиме. Пластмассовый корпус подобных фотоаппа-
ратов очень напоминал по форме этот аксессуар из ванной комнаты, отчего камеры и полу-
чили такое прозвище. Чуть позже появились полностью автоматические цифровые камеры,
которые унаследовали эту обидную кличку от своих предшественников. Кстати, данный тер-
мин нисколько не должен обижать владельцев таких камер, поскольку среди любительских
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цифровых камер, умещающихся в кармане рубашки, есть очень и очень достойные экзем-
пляры, снимающие фото потрясающего качества.

Другая разновидность цифровых фотоаппаратов – любительские камеры, внешне
очень напоминающие профессиональные. У них достаточно внушительные габариты (в кар-
мане не поносишь), приличный вес, большой, не убирающийся в корпус объектив и (самое
главное) возможность вручную выбирать режимы съемки.

Наконец, упомянем профессиональные фотоаппараты. Они позволяют делать снимки
высочайшего качества и дают фотографу полный контроль над режимами съемки. Такими
камерами обладают в основном либо заядлые фотолюбители, либо те, чья работа нераз-
рывно связана с фотографией: фотокорреспонденты, фотохудожники, дизайнеры. Стои-
мость подобных камер может измеряться десятками тысяч рублей.

Мы не случайно отвлеклись от основной темы и привели такую, хоть и упрощенную,
классификацию фотокамер. Дело в том, что независимо от того, какой камерой был сделан
снимок, он нуждается в обработке. В большей или меньшей степени в зависимости от каче-
ства снимка и условий съемки. Нередки случаи, когда снимок, сделанный «мыльницей», зна-
чительно превосходит по качеству снимок, выполненный в тех же условиях дорогой «зер-
калкой». Возможно, был выбран немного другой ракурс, и игра света и тени на снимаемом
объекте совершенно преобразила изображение.

Таким образом, становится понятно, что обрабатывать и ретушировать надо все
снимки, вне зависимости от того, какой камерой они сняты. И владельцы дорогих камер
понимают это в большей степени, поскольку, как правило, являются именно теми людьми,
чья жизнь неразрывно связана с фотоделом.

Итак, именно обработка снимка в программе редактирования растровой графики (в
нашем случае – в Photoshop) превращает обычного фотографа в фотографа-художника. Здесь
уже можно творить и фантазировать. Совершенно необязательно, чтобы конечное фотоизоб-
ражение выглядело как в жизни. Многие фотографы, наоборот, обесцвечивают свои работы,
считая, что в черно-белом снимке есть «душа». Или можно, например, создать таинствен-
ную и романтическую обстановку на снимке, «поиграв» с яркостью и контрастностью изоб-
ражения. Словом, компьютер и программа Photoshop позволяют преобразовать снимок в тот
вид, каким бы мы хотели его видеть. И для этого есть все средства.
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Глава 1

Adobe Bridge
 

Когда на компьютере хранятся сотни и уж тем более тысячи фотографий, неизбежно
возникает вопрос, как их систематизировать, находить и просматривать. Кто-то, возможно,
решит создать тематические папки и упорядочивать фотографии по ним. Например, можно
создать папки 2005, 2006, 2007, внутри них – папки Январь, Февраль, Март… И помещать
цифровые фотографии в эти папки согласно периоду съемки. Можно пойти другим путем:
создать папки Новый год 2008, Выпускной, Отпуск в Анапе, то есть упорядочивать фото-
графии по событию или месту съемки. В большинстве случаев, когда количество фотогра-
фий начинает измеряться сотнями и тысячами, неизбежно появляется путаница. На жестком
диске появляется огромное количество папок, есть большая вероятность случайно записать
файлы в другую папку, а уж отобрать фотографии, например, с вашим любимым котом –
задача невероятно сложная. Ведь кот мог быть сфотографирован и в Новый год, и 5 марта
2005 года, и его фотографии могут находиться практически в любой папке. Просматривать
придется все снимки.

Многим пользователям знакомы программы для упорядочивания и просмотра цифро-
вых фотографий, например ACDSee. В операционную систему Windows Vista также встро-
ена программа Фотоальбом Windows, позволяющая упорядочивать фотографии по дате
съемки, ключевым словам или рейтингу. Но мы предлагаем вам обратить внимание на про-
грамму, которую вы получаете в придачу к Photoshop CS4. Это программа Adobe Bridge.
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Интерфейс программы Bridge

 
Bridge в переводе с английского означает «мост». Назначение программы действи-

тельно очень схоже с функциями моста. С ее помощью можно просматривать, упорядочи-
вать, находить и загружать самые разные документы, созданные с помощью программ пакета
Adobe Creative Suite. В Adobe Bridge можно быстро найти и просмотреть документ Illustrator,
PDF-файл, проект After Effects, графические файлы самых разных форматов и многое дру-
гое. Отсюда же, из Bridge, любой из этих файлов можно открыть в соответствующей про-
грамме для редактирования или экспортировать в документ (проект), создаваемый в другой
программе. Возможно, в данный момент вам не все понятно, ничего страшного. Эта глава
полностью посвящена программе Bridge, и мы рассмотрим ее очень подробно. Вы поймете,
что это очень удобный инструмент для наведения порядка в своем цифровом фотоальбоме
(рис. 1.1).

Рис. 1.1. Окно программы Adobe Bridge

Рабочее окно программы Bridge состоит из нескольких областей. Названия этих обла-
стей (панелей) вы видите на ярлыках вкладок, расположенных в левой верхней части каж-
дой панели.

Рассмотрим эти панели по порядку.
• Favorites (Избранное). На этой панели расположены ярлыки нескольких папок.

Содержимое панели можно пополнять, добавляя на нее, например, папки, в которых хра-
нятся ваши фотографии.

• Folders (Папки). Данная панель представляет собой обычный проводник Windows.
На ней вы видите древовидную структуру всех папок компьютера.

• Content (Содержимое). По умолчанию это самая большая панель. На ней отобража-
ются эскизы файлов, хранящихся в папке, выбранной на панели Favorites или Folders. Гра-
фические файлы представлены в виде эскизов (миниатюрных изображений), поэтому вы
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можете быстро найти нужную фотографию в текущей папке. Размеры эскизов можно менять
в широком диапазоне, но об этом чуть позже.

• Preview (Просмотр). Данная панель служит для увеличенного просмотра выбранной
фотографии (или видеофайла). Размер отображаемого изображения ограничивается разме-
рами этой панели, но размеры любой панели можно изменить.

• Metadata (Сведения). На этой панели выводится исчерпывающая информация о
файле, выделенном на панели Content. И слово «исчерпывающая» здесь действительно
уместно. Из информации о файле вы можете узнать даже модель и серийный номер фото-
аппарата, которым был сделан снимок. Здесь же можно внести дополнительную информа-
цию, которая будет сохранена прямо в графическом файле, то есть вы сможете прочитать
эти данные (например, имя фотографа, место и обстоятельства съемки) на любом другом
компьютере.

• Keywords (Ключевые слова). Данная панель содержит список ключевых слов, с
которыми вы можете ассоциировать выделенную фотографию. Ключевые слова позволяют
быстро отобрать фотографии, связанные с каким-либо событием или содержащие изобра-
жение нужных людей, животных, растений, объектов. Чуть позже мы раскроем тему ключе-
вых слов более подробно.

• Filter (Фильтр). Эта панель содержит список фильтров, по которым вы можете отби-
рать нужные изображения для просмотра, копирования или редактирования. Например,
фотографии, в которых встречается указанное ключевое слово, или фотографии, снятые в
определенный день. Фильтров достаточно много, поэтому пока ограничимся таким упро-
щенным описанием панели.

• Collections (Коллекции). Программа Adobe Bridge позволяет создавать так называе-
мые коллекции. Коллекции – это виртуальные папки, в которые вы можете добавить фото-
графии, хранящиеся в самых разных папках (физических) и даже на разных дисках. Таким
образом, выбрав ранее созданную коллекцию, вы отобразите в окне программы графические
(и не только) файлы, где бы они ни находились. Программа ведет собственную базу данных,
в которой прописывается реальное размещение этих файлов на дисках. А для пользователя
файлы как бы располагаются в одной папке – коллекции.

В верхней части окна программы расположена строка меню, что типично почти для
всех приложений Windows. Ниже находятся кнопки для вызова часто используемых команд
и строка навигации, практически не отличающаяся от адресной строки проводника Windows
Vista. На этом мы закончим краткий обзор рабочего пространства программы Bridge и перей-
дем к более детальному изучению работы с ней.
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Организация рабочего пространства

 
На панели Content (Содержимое) отображаются эскизы файлов, хранящихся в папке,

выбранной на панели Favorites (Избранное) или Folders (Папки). Причем на данной панели
отображаются эскизы любых файлов, в том числе и не поддерживаемых программой Bridge.
То есть здесь вы можете увидеть значки текстовых файлов, системных библиотек, приложе-
ний и т. д.

Файлы, просмотр которых поддерживается программой Bridge, отображаются в виде
эскизов (миниатюрных изображений). Напомним, что Bridge поддерживает просмотр фай-
лов, создаваемых в самых разных программах пакета Creative Suite. То есть на панели
Content могут отображаться эскизы графических файлов, видеороликов, флеш-анимации,
PDF-документов, проектов After Effects, документов Illustrator и InDesign и т. д.

Чтобы перейти в папку, хранящую нужные для просмотра файлы, надо выбрать эту
папку на панели Folders (рис. 1.2). Даная панель является клоном проводника Windows и
содержит список всех дисковых устройств и папок компьютера, организованный в древо-
видную структуру.

Рис. 1.2. Панель Folders

После выделения на панели Folders нужной папки содержимое последней отобража-
ется на панели Content.

Размер эскизов можно изменять в широких пределах с помощью ползункового регуля-
тора, расположенного в нижней части окна программы.

При выделении эскиза на панели Preview (Просмотр) появляется его увеличенное
изображение. Если выделен анимационный или видеофайл, то на панели Preview произво-
дится воспроизведение этого файла – Bridge обладает собственным медиапроигрывателем.

Для просмотра фотографий удобен режим Filmstrip (Диафильм). Он вызывается щелч-
ком по одноименной кнопке в верхней части окна программы. В режиме Filmstrip размеры
панели Preview увеличиваются, а панель Content перемещается в нижнюю часть окна про-
граммы. Все эскизы на панели Content выстраиваются в одну горизонтальную линию. Пере-
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мещаясь по эскизам слева направо и в обратном направлении, вы можете просмотреть все
фотографии на панели Preview.

Кроме того, вы можете изменить размер любой панели, перетащив ее границу с помо-
щью мыши. Смежные панели будут соответственно увеличиваться и уменьшаться, что
исключит возможность появления пустых пространств в окне программы. Это позволяет
рационально использовать экранное пространство.

При щелчке по кнопке Metadata (Сведения) на панели инструментов к эскизам файлов
добавляется информация: дата создания, цветовая модель, рейтинг, размер и т. д. (рис. 1.3).

Рис. 1.3. Отображение сведений об изображениях

Выбор режимов отображения интерфейса, как вы поняли, осуществляется с помо-
щью кнопок в верхней части окна программы. Но для переключения режимов можно также
использовать команды меню Window → Workspace (Окно → Рабочее пространство). Там
же находятся команды для сохранения и загрузки самостоятельно измененных конфигура-
ций рабочего пространства. То есть вы можете настроить рабочее пространство по своему
усмотрению и выбрать команду меню Window → Workspace → New Workspace (Окно →
Рабочее пространство → Новое рабочее пространство). Вам будет предложено указать имя
конфигурации интерфейса. После сохранения конфигурации указанное вами имя появится
среди команд меню Window → Workspace.

Примечание
При нажатии клавиши Tab панель Content разворачивается на все

окно программы. Остальные панели скрываются. Повторное нажатие Tab
возвращает окно программы к исходному состоянию.

В правой верхней части окна программы расположен раскрывающийся список для
выбора метода сортировки файлов на панели Content. Нетрудно догадаться, что при выборе
пункта Sort by Filename (Сортировать по имени файла) данного списка эскизы упорядочи-
ваются по имени соответствующего файла; By Date Created (По дате создания) – по дате
съемки или создания; By Type (По типу) – по типу файла и т. д.
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Просмотр фотографий

 
Вы уже знаете, что просмотреть фотографии можно на панели Preview. Изображение

выбранного файла помещается на данной панели в максимально возможном масштабе. Чем
больше размеры панели Preview, тем крупнее фотографии на ней.

1. Поместите указатель мыши на изображение на панели Preview. Указатель примет
вид лупы.

2. Щелкните левой кнопкой мыши. На изображении появится область, напоминающая
увеличительное стекло. В этой области в увеличенном виде отображается участок фотогра-
фии, по которому вы щелкнули (рис. 1.4).

Рис. 1.4. Увеличение фрагмента изображения на панели Preview

3. Поместите указатель мыши на появившееся «увеличительное стекло». Указатель
примет вид руки.

4. Удерживая левую кнопку мыши, перемещайте указатель по изображению. В «уве-
личительном стекле» будут появляться новые участки изображения.

Таким образом, вы можете рассмотреть мелкие детали изображения, не разворачивая
панель Preview на весь экран.

Чтобы выйти из режима увеличенного просмотра, надо щелкнуть по кнопке с крести-
ком в правом нижнем углу «увеличительного стекла».

Есть и другие способы просмотра изображений.
1. Выберите команду меню View → Preview Mode (Вид → Режим просмотра) или

нажмите сочетание клавиш Ctrl+B. Рабочее пространство будет развернуто на весь экран,
все панели будут скрыты, а на экране появятся фотографии из активной папки, расположен-
ные как бы в трехмерном пространстве (рис. 1.5).
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Рис. 1.5. Режим просмотра изображений

2. Нажимайте клавиши со стрелками влево и вправо. Фотографии будут перемещаться
по кругу.

Чтобы выйти из режима просмотра, достаточно нажать клавишу Esc.
Если вы хотите просто просмотреть все фотографии в выбранной папке, можно вос-

пользоваться режимом слайд-шоу. Это очень удобный способ просмотра, поскольку от вас
требуется только запустить данный режим. Смену картинок на экране программа берет на
себя.

Режим слайд-шоу запускается с помощью команды меню View → Slideshow (Вид →
Слайд-шоу) или сочетания клавиш Ctrl+L. В режиме слайд-шоу фотографии показываются
в полноэкранном режиме, то есть никакие элементы интерфейса программы на экране не
отображаются.

По прошествии определенного времени (по умолчанию 5 с) на экране автоматически
появляется следующая фотография из выбранной папки, пока все фотографии не будут пока-
заны либо вы не прервете демонстрацию слайдов сами. Фотографии меняют друг друга с
эффектом, называемым переходом. Чтобы выйти из режима демонстрации слайдов, доста-
точно нажать клавишу Esc.

Параметры слайд-шоу можно изменить. Для этого выполните команду View →
Slideshow Options (Вид → Параметры слайд-шоу) и в открывшемся диалоговом окне выбе-
рите подходящие параметры (рис. 1.6).
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Рис. 1.6. Диалоговое окно Slideshow Options



В.  С.  Пташинский.  «Photoshop CS4 для фотографов»

15

 
Упорядочивание и фильтрация фотографий

 
Очень непросто найти нужную фотографию, когда их тысячи. Существует множество

программ для упорядочивания фотографий в различные коллекции и сборники. Отметим,
что программа Bridge устанавливается вместе с программой Photoshop, а также с другими
программами пакета Creative Suite. Поэтому необходимость в установке программ сторон-
них производителей отпадает.

Программа Bridge содержит мощные инструменты для упорядочивания и сортировки
файлов. Файлам (в нашем случае – фотографиям) можно присваивать рейтинг (по пяти-
балльной шкале), ключевые слова, добавлять информацию в сведения. Также имеется воз-
можность создавать коллекции фотографий.

Начнем с самого простого – рейтинга файла.
 

Рейтинг
 

Рейтинг файла – это своего рода оценка, которую вы присваиваете фотографии. Каж-
дой фотографии можно присвоить оценку от одной до пяти звезд. Что принять за высшую
оценку, решайте сами. Например, за высшую оценку можно принять рейтинг «одна звезда»,
а за низшую – «пять звезд», или наоборот.

Что дает рейтинг? Допустим, вы открыли папку с некоторым количеством фотогра-
фий. Среди них есть удачные, не очень и совсем неудачные, которые, однако, могут еще
пригодиться. Удачным фотографиям вы присваиваете высший рейтинг, посредственным –
средний, ну а совсем плохим – низший. В дальнейшем можно отобразить в окне программы
Bridge фотографии с определенным рейтингом. Например, чтобы посмотреть лучшие фото-
графии (или подготовить их для печати), достаточно выбрать фильтрацию по высшему рей-
тингу. В результате все фотографии, не имеющие высшего рейтинга, будут скрыты.

Присвоить рейтинг очень просто.
1. На панели Content выделите фотографию, которой хотите присвоить высший рей-

тинг.
2. Выберите команду меню Label → ***** (Метка → *****) (рис. 1.7). Под эскизом

фотографии появятся пять звездочек, говорящих о том, что данному файлу присвоен соот-
ветствующий рейтинг.
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Рис. 1.7. Присвоение рейтинга выделенному изображению

Гораздо удобнее присваивать рейтинг сразу группе фотографий. Для этого сначала
надо выделить группу эскизов, а затем присвоить ей рейтинг.

1. Удерживая клавишу Ctrl, щелкните по эскизам всех удачных фотографий. Указанные
эскизы будут выделены.

2. Нажмите сочетание клавиш Ctrl+5. Всем выделенным фотографиям будет присвоен
рейтинг «пять звезд».

Обратите внимание: в первом случае для присвоения рейтинга мы использовали
команду меню, во втором – клавиатурное сочетание. Сочетания клавиши Ctrl с клавишами
1–5 выполняют присвоение соответствующего рейтинга, то есть Ctrl+1 – «одна звезда», Ctrl
+2 – «две звезды» и т. д.

Можно убрать информацию о рейтинге из фотографии. Для этого надо выделить эскиз
(или группу) и нажать сочетание клавиш Ctrl+0 или выполнить Label → No Rating (Метка
→ Без рейтинга).

Теперь о том, как использовать рейтинг для фильтрации фотографий.
1. Откройте группу Ratings (Рейтинги) на панели Filter (Фильтр).
2. Щелкните по пункту ***** в раскрытой группе. На панели Content останутся фото-

графии с рейтингом «пять звезд». Остальные эскизы будут скрыты (рис. 1.8).



В.  С.  Пташинский.  «Photoshop CS4 для фотографов»

17

Рис. 1.8. Отобраны «пятизвездочные» фотографии

Как видите, все настолько просто, что это даже не надо комментировать. Обратите вни-
мание, что слева от пункта ***** на панели Filter появился флажок, говорящий о том, что
в данный момент включена фильтрация по рейтингу. Чтобы отключить фильтр, достаточно
снова щелкнуть по пункту *****. На панели Content вновь отобразятся все эскизы.

Если в режиме включенного фильтра запустить слайд-шоу, то показываться будут
только отфильтрованные фотографии.

 
Ключевые слова

 
Пожалуй, самый удобный способ упорядочивания и фильтрации фотографий – это

использование так называемых ключевых слов.
Ключевое слово – это фраза или слово, как-то характеризующее фотографию. Напри-

мер, ключевым словом может быть имя запечатленного на фотографии человека, название
местности, где была сделана фотография, описание события и т. д. Кроме того, одна и та
же фотография может иметь несколько ключевых слов. Например, «дача», «лето», «при-
рода». Все эти ключевые слова так или иначе характеризуют фотографию. Если вы захо-
тите отобрать фотографии, снятые на даче, то ключевое слово «дача» в этом поможет. Слово
«природа» также имеет отношение к данной фотографии. При выборе летних фотографий
данное изображение тоже попадет в фильтр. Однако фотографии, снятые на даче зимой, ото-
браны не будут.

Ключевые слова для фотографии задаются на панели Keywords (Ключевые слова)
(рис. 1.9). На этой панели уже присутствуют группы, включающие определенные ключевые
слова. Например, в группе Events (События) содержатся ключевые слова «Birthday» («День
рождения»), «Graduation» («Выпускной») и «Wedding» («Свадьба»). Таким образом, чтобы,
например, пометить фотографию как свадебную, достаточно выделить ее эскиз и установить
флажок слева от ключевого слова «Wedding». Даже ничего не надо вводить.
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Рис. 1.9. Панель Keywords

Но имеющиеся группы и ключевые слова приведены лишь для примера. Вполне
понятно, что вам их будет явно недостаточно. Поэтому вы можете создать собственные
группы и включить в них любые другие ключевые слова. В дальнейшем вам будет доста-
точно лишь установить флажок слева от ключевого слова, чтобы пометить фотографию.

Создадим собственную группу и добавим в нее ключевые слова.
1. Щелкните правой кнопкой мыши по любому участку панели Keywords. Появится

контекстное меню.
2. В контекстном меню выберите команду New Keyword (Новое ключевое слово). На

панели отобразится поле ввода.
3. Введите название группы, например «Животные». Группа ключевых слов создана.

Осталось наполнить эту группу ключевыми словами.
4. Щелкните правой кнопкой мыши по созданной группе на панели Keywords.

Появится контекстное меню.
5. В контекстном меню выберите команду New Sub Keyword (Новое вложенное клю-

чевое слово). Отобразится поле для ввода создаваемого ключевого слова.
6. Введите ключевое слово, например «Кот».
7. Вышеописанным способом создайте еще несколько ключевых слов, например

«Собака», «Лев», «Жираф» и т. д.
Теперь у нас есть новая группа «Животные» с вложенными в нее ключевыми словами.

Слева от каждого из созданных ключевых слов расположены флажки, установив которые мы
добавим соответствующие ключевые слова к выделенным фотографиям. Если на выделен-
ной фотографии изображены лев и жираф, можно установить флажки для ключевых слов
«Лев» и «Жираф». А можно создать еще несколько групп с другими ключевыми словами,
характеризующими данную фотографию: «Африка», «Хищник», «Природа» и т. д.

На первый взгляд может показаться, что создание ключевых слов усложняет жизнь
пользователю. Да, на первом этапе приходится формировать базу ключевых слов. Но позже,
когда эта база будет создана, вам останется лишь выбрать подходящее ключевое слово из уже
имеющихся и просто установить для него флажок. Если же для какой-либо фотографии не
окажется подходящего ключевого слова, его можно будет добавить в базу в любой момент.
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Ключевыми словами можно помечать сразу целые группы фотографий. Достаточно
выделить несколько эскизов на панели Content и установить флажки для подходящих клю-
чевых слов.

Отдельные ключевые слова и их группы можно удалить. Для этого надо щелкнуть по
удаляемому ключевому слову правой кнопкой мыши и в появившемся контекстном меню
выбрать команду Delete (Удалить). Однако следует учитывать, что при удалении ключевого
слова оно удаляется из всех ассоциированных с ним фотографий.

Примечание
Ключевые слова, как и рейтинг, можно задавать не только

фотографиям, но и видеороликам, документам, векторным рисункам
(иными словами, любым файлам). В дальнейшем при отборе документов
по ключевому слову «жираф», например, вы можете найти не
только фотографии, но и видеофильмы, музыку и другие документы,
ассоциированные с ним. В этом и заключается удобство работы
с программой Bridge: это не просто организатор фотографий, но
и полноценный файловый менеджер с возможностями, намного
превосходящими обычный проводник Windows.

Теперь о том, как находить и отбирать фотографии по ключевым словам. Здесь также
используется панель Filter.

При открытии группы Keywords на панели Filter отображаются все ключевые слова,
встречающиеся в фотографиях текущей папки. Заметьте: не все ключевые слова, включен-
ные в базу данных, а только ассоциированные со всеми или некоторыми открытыми фото-
графиями.

Щелкнув по любому из ключевых слов на панели Filter, вы установите флажок слева от
данного слова, и на панели Content останутся эскизы только ассоциированных с ним фото-
графий (рис. 1.10). Все остальные фотографии будут скрыты. Если щелкнуть еще по одному
ключевому слову, то на панель Content добавятся эскизы с указанным ключевым словом.
Таким образом, вы можете отбирать фотографии сразу по нескольким ключевым словам.
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Рис. 1.10. Результат фильтрации по ключевому слову «кот»

Чтобы отключить фильтр, надо снова щелкнуть по ключевому слову.

При выборе пункта No Keywords (Без ключевых слов) вы отобразите эскизы фотогра-
фий, не ассоциированных ни с одним ключевым словом.

Внимание!
Ключевые слова, а также рейтинг не интегрируются в сам файл.

Программа Bridge формирует собственную базу данных, в которой
указываются расположение фотографии на диске и ассоциированные с ней
ключевые слова и рейтинг. Если вы перенесете фотографии на другой
компьютер, придется формировать базу ключевых слов заново. Впрочем,
саму базу ключевых слов можно экспортировать в текстовый файл, а затем
импортировать в программу Bridge на другом компьютере. Но привязка
ключевых слов к конкретным фотографиям при этом не сохранится.

Обратите внимание на поле, расположенное в правой верхней части окна программы
Bridge. Это поле также служит для поиска фотографий. Причем здесь поиск носит более
универсальный характер. Вы можете ввести в него ключевое слово (или часть слова). На
панели Content отобразятся фотографии, ассоциированные с данным ключевым словом (или
фотографии, в ключевом слове которых встречается указанное сочетание символов). Также
на панели Content отобразятся фотографии, в имени файла которых присутствует указанное
сочетание. Таким образом, вы можете искать фотографию по имени файла.

 
Другие способы фильтрации и поиска

 
Как вы уже, наверное, заметили, панель Filter содержит достаточно много групп. Все

эти группы предназначены для отбора фотографий, отвечающих определенным требова-
ниям.

Вот только некоторые из этих групп:
• File Type (Тип файла). В данной группе формируется список типов всех отображае-

мых на панели Content файлов. Выбрав, например, тип JPEG file (Файл JPEG), вы скроете
все файлы, кроме фотографий в формате JPEG;

• Date Created (Дата создания). Позволяет легко отобрать фотографии, созданные в
определенный день;

• Orientation (Ориентация). С помощью данной группы можно отобрать фотографии
только в альбомной или только в книжной ориентации;

• Model (Модель). Если отображаемые на панели Content фотографии сняты разными
фотоаппаратами, вы можете отобрать снимки, сделанные камерой конкретной модели. Дан-
ные о камере, а также о режимах съемки хранятся непосредственно в графическом файле.
Может возникнуть вопрос о том, зачем нужна такая фильтрация. А представьте, что вы точно
помните, каким фотоаппаратом делали снимки какого-то события, но не помните, когда это
было. Данный фильтр поможет отобрать снимки, сделанные конкретной камерой.

Как видите, фильтров достаточно много, и, вполне возможно, вы не будете пользо-
ваться всеми. Это и не требуется.

Вышеописанные способы фильтрации применимы лишь к снимкам, которые загру-
жены на панель Content. Но программа Bridge предлагает очень мощное средство поиска
файлов по всему компьютеру. Например, вы можете найти фотографии с указанным ключе-
вым словом, хранящиеся в разных папках и даже на разных дисках, снятые в определенный
день, или фотографии, имена файлов у которых начинаются с указанного вами сочетания



В.  С.  Пташинский.  «Photoshop CS4 для фотографов»

21

букв. Фильтров очень много, кроме того, вы можете создавать комбинированные фильтры.
Например, отобрать снимки, снятые в определенный день, размер которых не превышает
указанного значения.

Фильтр поиска задается в диалоговом окне Find (Найти) (рис. 1.11), которое вызыва-
ется с помощью команды меню Edit → Find (Правка → Найти) или сочетания клавиш Ctrl+F.

Рис. 1.11. Диалоговое окно Find

В раскрывающемся списке Look In (Искать в) выбирается папка, где будет осуществ-
ляться поиск. Если в данном списке нужной папки нет, следует выбрать пункт Browse
(Обзор) и в открывшемся диалоговом окне указать нужную папку.

В нижней части диалогового окна Find расположено два флажка:
• Include All Subfolders (Включая вложенные папки). При установленном флажке поиск

будет осуществляться не только в указанной папке, но и во всех вложенных в нее папках;
• Include Non-indexed Files (Включая неиндексированные файлы). Если флажок уста-

новлен, поиск будет осуществляться и в неиндексированных местах.
В группе Criteria (Критерии) задается фильтр поиска. Чтобы разобраться с созданием

фильтра, рассмотрим простой пример. Допустим, нам надо отобрать все файлы, снятые 1
марта 2007 года и содержащие ключевое слово «свадьба». Для этого выполним следующие
действия.

1. В левом раскрывающемся списке в группе Criteria выберем пункт Date Created (Дата
создания).

2. В среднем раскрывающемся списке выберем пункт equals (равно).
3. В поле, расположенном правее, введем 01.03.2007. Первый фильтр задан. Теперь

надо создать второй фильтр.
4. Щелкнем по кнопке со знаком «плюс» в правой части группы Criteria. Появится еще

один набор элементов управления для создания фильтра.
5. В левом раскрывающемся списке выберем пункт Keywords (Ключевые слова).
6. В среднем раскрывающемся списке отметим пункт contains (содержит).
7. В поле, расположенном правее, введем текст «Свадьба».
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Фильтр создан. Обратите внимание, что во втором фильтре мы выбрали условие
contains. Это означает, что в фильтр попадут файлы, содержащие в качестве ключевого слова
фразы типа «моя свадьба», «свадьба друга», «свадьба на природе» и т. д. Если же выбрать
условие equals, то в фильтр попадут только файлы с ключевым словом «свадьба».

Теперь обратите внимание на раскрывающийся список Match (Совпадение). Он содер-
жит два пункта:

• If all criteria are met (Если все критерии совпадут). Будут найдены файлы, отвечающие
обоим пунктам фильтра;

• If any criteria are met (Если некоторые критерии совпадут). Будут найдены фотогра-
фии, отвечающие условиям любого пункта фильтра. То есть в нашем примере могут быть
найдены фотографии, снятые 1 марта 2007 года, но не имеющие к свадьбе никакого отноше-
ния, и, наоборот, свадебные фотографии, снятые в другой день. Среди найденных, конечно,
будут присутствовать искомые снимки, но лишних может оказаться достаточно много.

Таким образом, в нашем примере в списке Match следует выбрать пункт If all criteria
are met.

После щелчка по кнопке Find начнется поиск файлов, отвечающих условиям создан-
ного нами фильтра. Поиск может занять некоторое время. По окончании поиска все файлы,
отвечающие условиям поиска, отобразятся в виде эскизов и значков на панели Content. При
этом они могут располагаться в самых разных папках и даже на разных дисках. Далее работа
с этими файлами ведется обычным образом. Вы можете присваивать им рейтинги, ключевые
слова, добавлять в коллекции или применять к ним групповые преобразования.

 
Коллекции

 
Еще один удобный инструмент для организации фотографий (и других файлов) –

создание коллекций. Представьте, что вы складываете фотографии в фотоальбом. Таких
фотоальбомов у вас несколько. В одном оказываются семейные фотографии, в другом –
фотографии, снятые в отпуске, в третьем – снимки с вечеринок и т. д. Коллекции представ-
ляют собой виртуальные фотоальбомы, в которые можно «сложить» самые разные снимки. В
дальнейшем, открыв ту или иную коллекцию, вы отобразите на панели Content фотографии,
хранящиеся в данной коллекции. Самое главное удобство коллекции в том, что в нее можно
складывать файлы из разных папок и дисков. То есть вам не придется «перетряхивать» все
папки на компьютере в поисках нужной фотографии. Вы будете точно знать, что она хра-
нится в определенной коллекции, а место расположения фотографии значения не имеет.

Создадим новую коллекцию.
1. Перейдите на панель Collections (Коллекции).
2. Щелкните правой кнопкой мыши по любому участку панели Collections. Появится

контекстное меню.
3. В контекстном меню выберите пункт New Collection (Новая коллекция). На панели

Collections отобразится значок коллекции и поле для ввода имени коллекции.
4. Введите название коллекции и нажмите клавишу Enter. Имя коллекции должно соот-

ветствовать ее содержимому, например «Семейный фотоальбом».
Коллекция создана. Но в данный момент она пуста. Нам надо наполнить ее фотогра-

фиями. Здесь все просто. Перетаскивайте эскизы, соответствующие коллекции, с панели
Content на значок созданной коллекции. Можно перетащить сразу группу эскизов, предвари-
тельно ее выделив. Чтобы добавить в коллекцию файлы из другой папки, отобразите содер-
жимое этой папки на панели Content и перетащите на значок коллекции нужные эскизы.

Вы можете создать любое количество коллекций, причем некоторые фотографии могут
присутствовать сразу в нескольких из них. Например, коллекция с семейными фотографи-
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ями может содержать снимок, сделанный в отпуске, если вы проводили его с семьей. Эта же
фотография будет содержаться в коллекции с фотографиями из отпуска.

В любой момент ранее созданную коллекцию можно пополнять новыми снимками.
Теперь, выделив какую-либо коллекцию на панели Collections, вы отобразите только

те снимки, которые содержатся в этой коллекции (рис. 1.12). Чтобы удалить снимок из кол-
лекции, достаточно выделить его на панели Content и щелкнуть по кнопке Remove From
Collection (Удалить из коллекции), расположенной в верхней части панели Content. При этом
файл будет удален только из коллекции. С физическим файлом на жестком диске ничего не
произойдет. Вы по-прежнему сможете найти его в папке размещения.

Рис. 1.12. Содержимое коллекции «Семейный фотоальбом»

Ранее созданную коллекцию можно удалить. Достаточно щелкнуть правой кнопкой
мыши по значку коллекции на панели Collections и в появившемся контекстном меню
выбрать команду Delete (Удалить). Файлы, входящие в коллекцию, удалены при этом не
будут.
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Пакетные преобразования

 
Очень часто приходится выполнять одинаковые преобразования для нескольких изоб-

ражений. Например, переименовать файлы, преобразовать в другой формат, изменить раз-
меры изображения и т. д. В этом нет ничего сложного, но, если изменять параметры каж-
дой фотографии в отдельности, на это может уйти много времени. А вместе с ним и всякая
охота заниматься этим делом. Программа Bridge предлагает несколько инструментов для
группового преобразования файлов. В частности, вы можете переименовать группу фай-
лов, преобразовать растровые изображения в форматы JPEG, TIFF и PSD, изменить размеры
изображений, применить сразу к нескольким изображениям макрос, имеющийся в арсенале
Photoshop, и т. п.

Рассмотрим несколько возможностей пакетного преобразования файлов.
 

Групповое переименование
 

Выделенную на панели Content группу файлов можно переименовать, используя раз-
личные алгоритмы генерации имен файлов. Вкратце рассмотрим, как это делается.

1. Выделите группу фотографий на панели Content.
2. Выберите команду меню Tools → Batch Rename (Инструменты → Групповое пере-

именование). На экране появится диалоговое окно Batch Rename (Групповое переименова-
ние) (рис. 1.13).

Рис. 1.13. Диалоговое окно Batch Rename

3. Настройте параметры переименования файлов (мы их опишем чуть ниже) и щелк-
ните по кнопке Rename (Переименовать). Выделенные файлы будут переименованы.

Теперь рассмотрим содержимое диалогового окна Batch Rename.
В верхней части данного диалогового окна расположен переключатель, с помощью

которого выбирается папка, где будут сохранены переименованные файлы:
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• Rename in same folder (Переименовать в этой же папке). Файлы будут переименованы
и сохранены в папках своего размещения;

• Move to other folder (Переместить в другую папку). Файлы будут переименованы и
перемещены в другую папку. Папка назначения выбирается в диалоговом окне Browse files
and folders (Обзор файлов и папок), которое вызывается с помощью кнопки Browse (Обзор);

• Copy to other folder (Копировать в другую папку). Создаются копии файлов, которые
будут переименованы и помещены в указанную вами папку. Используйте кнопку Browse для
выбора папки назначения.

В группе New Filenames (Новые имена файлов) задается алгоритм генерации новых
имен для переименовываемых файлов. Рассмотрим пример. Переименуем файлы так, чтобы
их имена выглядели как Выпускной-31052008-0001JPG, где «Выпускной» – слово, характе-
ризующее содержание фотографий, «31052008» – дата съемки, а «0001» – порядковый номер
файла. Порядковый номер каждого снимка будет разным, поскольку в одной папке не могут
содержаться файлы с одинаковыми именами.

1. В верхнем раскрывающемся списке группы New Filenames выберите пункт Text
(Текст).

2. В поле, расположенном справа, введите текст «Выпускной-» (дефис мы будем
использовать как разделитель между составляющими имени файла).

3. В первом раскрывающемся списке второго ряда выберите пункт Date Time (Дата
Время).

4. Во втором раскрывающемся списке второго ряда отметьте пункт Date Created (Дата
создания).

5. В третьем раскрывающемся списке второго ряда выберите формат даты –
DDMMYYYY (ДДММГГГГ).

6. В раскрывающемся списке третьего ряда выберите пункт Text, а в поле справа вве-
дите дефис. Он нам нужен как разделитель.

7. В первом раскрывающемся списке четвертого ряда выберите пункт Sequence Number
(Порядковый номер).

8. В поле, расположенном правее, введите цифру 1, чтобы файлы нумеровались с еди-
ницы.

9. И наконец, в правом раскрывающемся списке четвертого ряда выберите количество
разрядов порядкового номера – Four Digits (Четыре цифры). Таким образом, порядковый
номер файла будет указан как 0001, 0002, 0003 и т. д.

Теперь взгляните на строку New filename (Новое имя файла) в нижней части диалого-
вого окна Batch Rename. В этой строке указывается созданный вами формат имени файлов.
Именно по этой маске переименовываемым файлам будут присвоены новые имена. Пере-
именование произойдет только после щелчка по кнопке Rename (Переименовать).

Как видите, ничего сложного здесь нет. В раскрывающихся списках группы New
Filenames можно выбрать самые разные данные, которые будут указаны в новых именах
файлов: произвольный текст, порядковый номер, дату создания или изменения, различные
данные EXIF и многое другое.

 
Пакетное преобразование формата и размера изображений

 
Нередко требуется изменить размеры группы изображений, а также преобразовать их

в другой графический формат. Программа Bridge позволяет сделать это с использованием
ресурсов Photoshop.

Изменим размеры нескольких изображений и преобразуем их в формат Photoshop
(PSD).
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1. Выделите группу изображений на панели Content.
2. Выберите команду меню Tools → Photoshop → Image Processor (Инструменты →

Photoshop → Преобразование изображений). Будет загружена программа Photoshop, и в ее
окне откроется диалоговое окно Image Processor (Преобразование изображений) (рис. 1.14).

Рис. 1.14. Диалоговое окно Image Processor

3. В диалоговом окне Image Processor установите переключатель Select location to save
processed images (Выберите папку для сохранения преобразованных изображений) в положе-
ние Save in Same Location (Сохранить в той же папке) или в положение Select Folder (Выбрать
папку). В последнем случае надо будет указать целевую папку.

4. Установите флажок Save as PSD (Сохранить как PSD). Если флажки Save as JPEG
(Сохранить как JPEG) и Save as TIFF (Сохранить как TIFF) установлены, снимите их.

5. В группе Save as PSD установите флажок Resize to Fit (Изменить размеры до) и в
полях W (Ширина) и H (Высота) введите новые размеры, например 1000 и 750.

6. Щелкните по кнопке Run (Выполнить). Выделенные в программе Bridge изображе-
ния будут преобразованы в формат PSD, их размеры будут измены в соответствии с указан-
ными вами значениями, а сами изображения (уже преобразованные) будут открыты в про-
грамме Photoshop.
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Вышеописанными примерами возможности пакетной обработки изображений сред-
ствами программы Bridge не ограничиваются. Но мы не будем детально разбирать Bridge –
ей уже было уделено много внимания.

Итак, программа Bridge объединяет в себе удобный файловый менеджер, средство для
просмотра, поиска и упорядочивания различных файлов (не только изображений, но и дру-
гих документов), а также инструменты для пакетной обработки документов. Несомненным
плюсом является отсутствие необходимости приобретать данную программу. Она устанав-
ливается на компьютер автоматически при установке почти любой программы из пакета
Adobe Creative Suite 4.

А сейчас перейдем непосредственно к тому, ради чего и задумывалась эта книга: к
обработке изображений средствами программы Photoshop.
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Глава 2

Редактирование изображения в Camera RAW
 

Результатом снимка всех современных цифровых камер является графический файл
в формате JPEG. Каждому, кто хоть немного знаком с растровой графикой, известно, что
фотография в формате JPEG занимает на диске (или карте памяти) совсем немного места и в
основном обеспечивает достаточно качественное изображение (по крайней мере достаточ-
ное для любительского фотоальбома). Некоторые камеры способны также сохранять снимки
в формате TIFF. Размеры файлов TIFF, конечно, больше, но это только положительно ска-
зывается на качестве изображения. Профессиональные и полупрофессиональные камеры
умеют сохранять изображение в формате RAW.

Что такое RAW? По сути, ни форматом, ни стандартом это не является. Это изображе-
ние, полученное напрямую с матрицы фотоаппарата и записанное в виде файла.

Чтобы ясно представлять, что такое RAW-файл, нужно понимать, что происходит
внутри цифровой камеры в момент нажатия кнопки спуска затвора. Снимаемое изображе-
ние попадает в объектив камеры и проецируется на светочувствительную матрицу. Именно
на этой матрице оно раскладывается на красные, зеленые и синие точки, и эти точки в виде
электрических сигналов попадают в процессор камеры (рис. 2.1). Процессор обрабатывает
полученное изображение в соответствии с настройками камеры. Например, если вы устано-
вили режим съемки в условиях люминесцентного освещения, электроника камеры (процес-
сор) преобразует цвета полученного с матрицы изображения путем подавления или усиле-
ния каких-либо оттенков, то есть применяет цветовой фильтр (и в ряде случаев делает это
весьма удачно). Также процессор может применять к полученному изображению и другие
преобразования. Например, осветлять или затенять его в зависимости от выбранной экспо-
зиции, применять различные эффекты и т. д.

Рис. 2.1. Процесс съемки

В ряде случаев автоматическая обработка снимка процессором камеры значительно
упрощает жизнь фотографу-любителю. Действительно, ему остается лишь щелкать кнопкой
фотоаппарата. Затем можно извлечь карту памяти и отнести ее в ближайшую фотолабора-
торию, где тут же отпечатают снимки. И порой снимки очень высокого качества: современ-
ные фотоаппараты (даже сравнительно дешевые) обладают очень неплохой цветопередачей
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и глубиной резкости. Эти снимки действительно могут занять достойное место в домашнем
фотоальбоме или на страницах интернет-ресурсов.

Особенно хорошие снимки получаются в условиях уличного освещения. Съемка в
сумерках или при искусственном освещении уже может преподнести немало неприятных
сюрпризов. Процессор фотоаппарата часто ошибается. То цвета искажает, то с освещенно-
стью путает.

Профессионалы стараются не доверять автоматике, считая, что снимок лучше дове-
сти «до ума» собственными руками. Кроме того, работа над снимком в программе для обра-
ботки растровой графики – это своего рода искусство. Вы знаете, к какому результату хотите
прийти, и делаете для этого все что нужно. Конечно, снимок, который был испорчен (или
недостаточно хорошо обработан) процессором камеры, можно как-то спасти в растровом
редакторе, но искажения, внесенные процессором, да еще и сжатием по алгоритму JPEG,
уже никуда не денутся. И пусть они будут малозаметны, но все же останутся.

Формат TIFF как формат растровой графики, конечно, содержит гораздо меньше иска-
жений. Недаром этот формат используется в полиграфии. Но если картинка прошла через
процессор камеры, снова приходится иметь дело с искажениями (цветовыми или яркост-
ными).

Формат RAW – это как раз то, что позволяет получить наиболее качественное изобра-
жение. Электрические сигналы с матрицы, минуя процессорную обработку, сразу записы-
ваются на карту памяти в виде файлов. Соответственно, вы получаете неискаженное изоб-
ражение из цветных точек, полученных «из первых рук». А всю обработку снимка можно
выполнить самостоятельно. И улучшите вы снимок или испортите, зависит уже только от
вашего умения работать с растровыми редакторами. Кстати, чаще всего необработанный
снимок в формате RAW выглядит очень непривлекательно: невысокая контрастность, блек-
лые цвета – это и есть отсутствие обработки.

Еще отметим, что изображение в формате JPEG состоит из гораздо меньшего коли-
чества точек, коими определяется разрешение файла. Допустим, мы имеем изображение,
состоящее из 1000 точек по горизонтали и 750 точек по вертикали. По логике, изображение
должно состоять из 750 000 точек. Но это не совсем так. Формат JPEG заменяет некоторые
точки математическими выражениями, на основе которых изображение как бы воссоздается
на экране монитора. Переходная точка между красной и синей воссоздается на компьютере
на основе соседних точек путем сравнения их цвета и яркости. Формат JPEG имеет раз-
ные степени сжатия, которые влияют на конечный размер файла и качество изображения.
Чем выше степень сжатия файла, тем меньше размер файла и ниже качество изображения,
и наоборот.

Формат RAW, в отличие от JPEG, содержит информацию абсолютно обо всех точках
изображения, что, конечно, не может не сказаться на размере файла. Размер файла RAW
зависит в первую очередь от разрешения камеры, измеряемой, как известно, в мегапикселах,
и может составлять до нескольких десятков мегабайт. Поэтому в любительской съемке отда-
ется предпочтение формату JPEG (можно поступиться качеством картинки ради небольшого
размера файла, а это делает возможным хранение тысяч снимков на одной карте памяти).

Кроме того, формат JPEG универсален и стандартизирован. Файлы этого формата
могут быть открыты на любом компьютере без установки дополнительных программ, про-
смотрены на DVD-проигрывателе, портативных устройствах и даже на дисплее телефона.
Формат RAW, как мы уже отметили, не имеет каких-либо стандартов. Просмотреть его
можно только в специальных программах, а о просмотре на экране телевизора через DVD-
проигрыватель и говорить не приходится.

И все же формат RAW востребован среди профессионалов. Думаем, уже понятно,
почему. Профессионалу не нужны тысячи снимков на одной карте памяти. Часто он выходит
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«на охоту» ради одного-двух снимков. Профессионал не пойдет в фотолабораторию, чтобы
отдать снимок на печать. Сначала он его тщательно обработает на компьютере. Да и распе-
чатает сам. Фотомашины, установленные в различных фотоателье, тоже работают на «авто-
мате», штампуя снимки, не разбирая, где надо сделать светлее, а где лучше использовать
другую бумагу (да, конечное изображение зависит даже от типа бумаги). Но любителей это
мало волнует, что нормально. Совершенно необязательно всем становиться профессиона-
лами и фотохудожниками.

Итак, мы уже отметили, что RAW не является форматом, хотя для удобства применяем
к нему этот термин. И он не стандартизирован. То есть каждая фирма, выпускающая циф-
ровые камеры, упаковывает данные с матрицы в файл своим способом. У файлов RAW, сня-
тых на разных фотоаппаратах, различные расширения и алгоритм хранения информации.
Отсюда и несовместимость этого формата с программами и устройствами.

До недавнего времени для работы с фотографиями RAW приходилось использовать
специальные программы. Зачастую они были ориентированы на камеры конкретных произ-
водителей. Например, программа, предназначенная для работы с файлами RAW, снятыми
камерами Sony, могла совершенно не понимать файлы формата RAW от Canon, и наоборот.
Выпускались отдельные модули для программы Photoshop, с помощью которых становилось
возможным открытие и обработка RAW-файлов. Но с недавних пор в программу Photoshop
интегрирован инструмент Adobe Camera RAW (ACR), который позволяет открывать и редак-
тировать RAW-файлы если не от всех, то по крайней мере от основных производителей
фототехники.
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Adobe Camera RAW. Первое знакомство

 
Далеко не всегда при установке программы Photoshop выполняется ассоциация RAW-

файлов с данным приложением. Как мы уже отметили, файлы RAW от разных производи-
телей имеют разное расширение, а в Windows именно расширение определяет принадлеж-
ность файла к той или иной программе.

Поэтому при запуске RAW-файла из проводника Windows вы можете увидеть на экране
диалоговое окно с сообщением о том, что данный файл открыть не удалось, и предложением
выбрать нужное приложение самостоятельно.

Из программы Photoshop открыть RAW-файл можно только одним способом: выбрав
фильтр All Formats (Все форматы) в раскрывающемся списке Тип файлов (File Type) диало-
гового окна Open (Открыть). В этом случае в диалоговом окне будут отображены все типы
файлов, даже не имеющие отношения к растровой графике, и вы сможете выбрать нужный
RAW-файл.

Но удобнее всего открывать RAW-файл из программы Bridge. Во-первых, в Bridge
отображаются эскизы RAW-файлов, поэтому вы сразу видите, какой файл нужно открыть.
Во-вторых, из Bridge в Adobe Camera RAW можно загрузить не только RAW-файлы, но
и файлы других графических форматов (правда, целесообразность последнего несколько
сомнительна). Итак, чтобы открыть файл формата RAW для обработки, следует щелкнуть по
его эскизу правой кнопкой мыши и в появившемся контекстном меню выбрать команду Open
in Camera RAW (Открыть в Camera RAW). Будет загружена программа Adobe Photoshop, и
в ней откроется окно Camera RAW (рис. 2.2).

Рис. 2.2. Окно Camera RAW

Окно Camera RAW обладает свойствами диалогового окна. То есть мы не можем
перейти в окно программы Photoshop, не закрыв окна Camera RAW. Кроме того, как видите,
в окне Camera RAW отсутствует кнопка закрытия. Данное окно можно закрыть, лишь при-
менив сделанные изменения в изображении или отменив их.
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Окно Camera RAW не может быть пустым. Вы не можете открыть это окно, не загру-
зив в него изображение. Забегая вперед, отметим, что в данное окно можно загрузить сразу
несколько изображений и обрабатывать их по очереди или одновременно.

Рассмотрим окно Camera RAW.
В основной части окна размещается обрабатываемое изображение. Оно может быть

масштабировано с помощью кнопок и раскрывающегося списка в левой нижней части окна.
В верхней части окна расположена панель инструментов. Перечислим эти инстру-

менты слева направо (в скобках указаны соответствующие горячие клавиши):
• Zoom (Масштабирование) (Z);
• Hand (Рука) (H) – перемещение изображения в окне Camera RAW, если изображение

не помещается целиком в окне;
• White Balance (Баланс белого) (I) – установка баланса белого;
• Color Sampler (Образец цвета) (S) – взятие образцов цвета с изображения;
• Crop (Рамка) (C) – подрезка изображения. Кстати, в окне Camera RAW этот инстру-

мент имеет удобные предустановки, позволяющие подрезать изображение так, чтобы его
пропорции имели соотношение 1:1, 2:3, 3:4, 4:5 и 5:7. Имеется также возможность вручную
установить нужные пропорции или фиксированный размер изображения;

• Straighten (Выпрямление) (A) – поворот изображения с одновременным кадрирова-
нием;

• Spot Removal (Ретушь) (B) – ретуширование и клонирование участков изображения;
• Red Eye Removal (Устранение эффекта «красных глаз») (E) – здесь, думаем, коммен-

тарии не нужны;
• Adjustment Brush (Настраивающая кисть) (K) – с помощью данного инструмента

можно откорректировать яркость, контрастность, экспозицию, насыщенность, резкость и
другие параметры отдельных участков изображения;

• Graduated Filter (Градиентная маска) (G) – создание градиентной маски, с помо-
щью которой можно изменить параметры части изображения. Например, плавно изменить
яркость от верхней до нижней части изображения;

• Open Preferences Dialog (Открыть диалог настройки параметров) (Ctrl+K) – это не
инструмент, а просто кнопка, вызывающая диалоговое окно, в котором можно настроить
некоторые параметры Camera RAW;

• Rotate Image 90 CCW (Повернуть на 90 против часовой стрелки) (L) и Rotate Image
90 CW (Повернуть на 90 по часовой стрелке) (R) – здесь, полагаем, все ясно.

Чуть позже мы познакомимся с некоторыми из вышеописанных инструментов подроб-
нее.

В правой части окна Camera RAW расположена цветовая гистограмма (как видите, она
состоит из четырех цветов: синего, красного и зеленого – это составляющие цветного изоб-
ражения, и белого – это усредненное значение трех предыдущих цветов, то есть белые и
серые тона). Под гистограммой находится информационная панель со значениями основных
цветов точки, на которой находится указатель мыши, значениями диафрагмы и выдержки,
при которых был сделан снимок, фокусным расстоянием и чувствительностью ISO.

Ниже расположена панель с вкладками. На вкладках находятся элементы управления
для коррекции изображения. Настроек достаточно много, мы пройдемся по ним чуть позже.

В нижней части окна Camera RAW (прямо под областью просмотра) расположена
ссылка, с помощью которой вызывается диалоговое окно Workflow Options (Свойства рабо-
чего пространства) для выбора рабочего пространства (рис. 2.3).
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Рис. 2.3. Диалоговое окно Workflow Options (Свойства рабочего пространства)

В раскрывающемся списке Space (Пространство) выбирается цветовое пространство
для работы. Для подготовки снимка к печати чаще используют Adobe RGB (1998), а для
просмотра и демонстрации изображения на экране можно выбрать sRGB.

В раскрывающемся списке Depth (Глубина) устанавливается глубина цвета изображе-
ния. Чаще всего используют глубину 8 бит на канал. Это означает, что для хранения инфор-
мации о цвете одной точки используется 8 бит памяти, то есть каждая точка может иметь 256
градаций яркости. Учитывая, что точка изображения состоит из трех цветных точек, получа-
ется 24 бита на одну точку, а это более 16 млн оттенков – более чем достаточно. Поэтому глу-
бину цвета 16 бит на канал в большинстве случаев использовать не имеет никакого смысла.

В раскрывающемся списке Size (Размер) задается размер изображения. Причем раз-
мер указывается как в пикселах по горизонтали и вертикали, так и в мегапикселах (общем
количестве точек, составляющих изображение). Увеличить размер изображения можно, но
не имеет смысла. Качественнее оно от этого не станет.

В поле Resolution (Разрешение) можно изменить разрешение снимка (количество точек
на один дюйм или один сантиметр). Для демонстрации изображения на экране достаточно
разрешения 72 точки на дюйм. Без необходимости лучше этот параметр не изменять.

И наконец, в нижней части окна Camera RAW расположены следующие кнопки:
• Save Image (Сохранить изображение). Позволяет сохранить обработанное или необ-

работанное изображение в форматах DNG (Digital Negative). Это тот же RAW, JPEG, TIFF
или PSD (собственный формат Photoshop);

• Open Image (Открыть изображение). Открывает обработанное изображение в про-
грамме Photoshop;

• Cancel (Отмена). Отменяет все выполненные изменения и закрывает окно Camera
RAW;

• Done (Готово). Сохраняет изменения в RAW-файле и закрывает окно Camera RAW.
Сам файл при этом в программу Photoshop не загружается.

Интерфейс Camera RAW достаточно сложен для диалогового окна и слишком прост,
чтобы считать Camera RAW программой. Это скорее ни то, ни другое. Это модуль программы
Photoshop, к тому же регулярно обновляющийся. Как правило, интерфейс данного модуля
практически не меняется от версии к версии. Меняется лишь количество поддерживаемых
камер.
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Коррекция изображения

 
Модуль Camera RAW предназначен в основном для предварительной обработки изоб-

ражения. Но часто, если вашей целью не стоит снабдить снимок какими-либо эффектами,
надписями или создать фотокомпозицию, редактирования в Camera RAW бывает доста-
точно, чтобы опубликовать фотографию в Интернете или распечатать.

Корректировать параметры изображения можно в любом порядке. Но лучше всего
начать с баланса белого.

 
Настройка баланса белого

 
Очень частая проблема снимков – это искаженные цвета. Особенно часто цвета иска-

жены на снимках, сделанных в помещении. Здесь ключевую роль играет тип освещения.
Люминесцентные лампы добавляют цветам на фотографии холодный синий оттенок, а
лампы накаливания, наоборот, делают фотографию слишком теплой, добавляя желтые и
рыжие тона. Вы наверняка часто наблюдали подобный эффект. Все современные камеры
содержат настройки баланса белого. Режимы баланса белого в камере так и называются:
«дневной свет», «облачно», «пасмурно», «лампы накаливания» и «люминесцентное осве-
щение». В некоторых камерах режимов баланса белого может быть больше, в некоторых –
меньше. Обработкой изображения занимается электроника камеры, которая подавляет опре-
деленные оттенки. Но мы говорим о RAW-изображении, которое не обрабатывается процес-
сором камеры.

Баланс белого (и некоторые другие параметры) в Camera RAW настраиваются на
вкладке Basic (Основные).

Примечание
На ярлыках вкладок, расположенных на панели в правой части окна

Camera RAW, как вы могли заметить, названия не нанесены. Название вы
можете увидеть чуть ниже (под ярлыком вкладки) или во всплывающей
подсказке, которая появляется при наведении указателя на ярлык вкладки.

В верхней части вкладки Basic расположен раскрывающийся список White Balance
(Баланс белого). В этом списке присутствуют такие пункты, как Auto (Авто), Daylight (Днев-
ное освещение), Cloudy (Облачно), Shade (Тень), Tungsten (Пасмурно), Fluorescent (Люми-
несцентное освещение), Flash (Вспышка), Custom (Вручную). Нетрудно догадаться, что,
например, для устранения цветовых искажений в результате съемки в пасмурную погоду
надо выбрать пункт Tungsten. Остальные пункты выбираются так же, в зависимости от усло-
вий съемки. В ряде случаев этого бывает достаточно, чтобы восстановить естественность
цветов на снимке (рис. 2.4).
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Рис. 2.4. Результат настройки баланса белого

Отдельно стоит отметить пункты Auto и Custom раскрывающегося списка White
Balance. В режиме Auto программа оценивает изображение самостоятельно и подавляет
преобладающий оттенок. В камерах, кстати, тоже присутствует подобный режим баланса
белого. В некоторых случаях режим Auto дает очень неплохие результаты.

В режиме Custom вы можете выровнять цвета вручную. Кстати, этот режим автома-
тически активируется при любом изменении положения регуляторов Temperature (Темпера-
тура) и Tint (Оттенок). Именно этими регуляторами можно настроить баланс белого вруч-
ную. Причем сделать это можно как с нуля, так и поступив следующим образом: выбрав
подходящий режим баланса белого в раскрывающемся списке White Balance, а затем более
тонко откорректировав цветовую гамму изображения регуляторами Temperature и Tint.

С помощью регулятора Temperature настраивается температура цвета: от холодных (в
левом положении регулятора) до теплых (в правом положении) оттенков. А регулятором
Tint можно изменить оттенок изображения, например добавить ему недостающие синие или
красные тона. Эти регуляторы можно использовать не только для установки правильного
баланса белого, но и чтобы исказить цвета на фотографии, если вы хотите добиться какого-
либо художественного эффекта.

Есть еще один удобный инструмент для настройки баланса белого. Однако его можно
применить, только если на изображении есть участки, которые в жизни должны быть
белыми, серыми или черными, то есть цветовые составляющие RGB присутствуют в них
в равных пропорциях. Особенно удачно инструмент применяется на белых участках (вер-
нее, участках, которые должны быть белыми в конечном итоге). И не важно, что на снимке
эти объекты имеют желтоватый или синеватый оттенок. Мы говорим об инструменте White
Balance, кнопка которого расположена в верхней части окна Camera RAW (третья слева).



В.  С.  Пташинский.  «Photoshop CS4 для фотографов»

36

 
Конец ознакомительного фрагмента.
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